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SERVICE AGREEMENT 
 
Sumitomo Electric Interconnect Products, Inc. offers a service agreement to the original end 
user or purchaser that this product is free from defects in materials or workmanship for a 
period of one (1) year from the date of purchase. During this period, the product will be 
repaired or replaced (with the same or similar model) at our discretion, without charge for 
either parts or labor. The service agreement shall not apply if the product is modified, 
tampered with, misused, subjected to abnormal working conditions, or used in any manner 
other than as directed by Sumitomo Electric Interconnect Products, Inc. 
 
REPAIR OR REPLACEMENT AS PROVIDED UNDER THE SERVICE AGREEMENT IS THE 
EXCLUSIVE REMEDY OF THE PURCHASER. THIS AGREEMENT IS IN LIEU OF ALL OTHER 
AGREEMENTS, EXPRESS OR IMPLIED, INCLUDING ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR USE OR PURPOSE, AND SUMITOMO 
ELECTRIC INTERCONNECT PRODUCTS, INC. SHALL IN NO EVENT BE LIABLE TO 
PURCHASER FOR INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND OR CHARACTER. 
 
Some states do not allow the exclusion or limitation of incidental or consequential damages 
or allow limitations on how long an implied service agreement lasts, so the above limitations 
or exclusions may not apply to you. This agreement gives you specific legal rights, and you 
may also have other rights which vary from state to state. 
 
To obtain service under this agreement, contact Sumitomo Electric Interconnect Products, 
Inc. at (800) 758-3515 or by mail at 915 Armorlite Drive, San Marcos, CA 92069-1440. 
 
 

SOFTWARE LICENSE AGREEMENT 
 

This is a legal agreement between you, the user, and Sumitomo Electric Interconnect 
Products, Inc. By installing SumiLabel, you agree to be bound by the terms of this 
agreement. If you do not agree to these terms, promptly return all items (systems, 
components, written materials, packaging) for a full refund. 
 
The software is protected by United States copyright laws and international treaties. You 
may make one copy of the software solely for backup or archival purposes. You may not 
rent or lease the software or copy the written materials accompanying the software. You 
may not reverse engineer, de-compile, or disassemble the software. 
 
 
Note: This guide is intended only to cover basic operation of and the most 
common procedures for your SumiMark IV® printer. For more information, please 
visit us on the web at www.SumiSupport.com.  
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I. Hardware Setup & Procedures 
 
 

Unpacking and Inspection 
 

This section is designed to assist you in readying the printer for use. Please consider it 
carefully in order to ensure that you have received all the necessary components for proper 
operation. 

1. Remove the top foam packing piece. 
2. Lift printer straight up and out of the box carefully, with adequate assistance. 
3. Remove and inspect the accessory kit and supplies. 

 
Important: Save box and all packing materials for future use, in the event the 
printer needs to be shipped. Units returned for service in non-approved 
packaging may void the warranty or increase repair costs due to shipping 
damage. 

 
Verify that the printer box contains the following materials:  

• SumiMark® IV 300dpi Printer 
• Spool Stand 
• Power Cord 

• USB A-to-B cable 
• Straight-edge Cutting Blade w/ Allen key for cutter set screws 
• USB flash drive containing SumiLabel and IMM software, basic manual, drivers and 

other utilities. 
• A sample ribbon roll with take-up ribbon core (preinstalled on the unit) 
• Sumilabel and IMM Software Activation Card 
• Notched Blade for Perforated Cuts (preinstalled on the unit) 
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Connecting Printer and Computer 
 
To connect your SumiMark® printer to your computer, you must connect the printer via 
USB, ethernet, or parallel to your computer. A USB cable is provided with the printer for 
your convenience. Refer to Figure 1 below for the labeled ports. 
 

Important: Use the cables that came with the printer, as they have been tested 
to ensure proper printing.  
 

 
Figure 1 

      

Ethernet Port 

 

USB Port (A-to-B) 

 

Parallel Port 

 

Power Plug Port 

 

Not used 
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Procedure 1a – Loading the Ribbon 
 

 
Figure 2 

 
1. Open the Tubing Access Cover.  
2. Rotate the red Print Head Latch counter-clockwise to open the print head module.  
3. Open the Side Access Door, unwrap the ribbon, and place the Ribbon Supply 

Roll on the Ribbon Supply Spindle located towards the back of the printer. Slide 
the core all the way to the back of the spindle. 

4. Place the Ribbon Take-up core on the Ribbon Take-Up Spindle, located towards 
the front of the printer. Slide the core all the way to the back of the spindle. 

5. Route the ribbon under the print head mechanism and around the back of the 
Ribbon Take-Up Core, then attach with tape to the Ribbon Take-Up Core.  

6. Tighten ribbon by manually rotating the Take-Up Core counter-clockwise.  
7. To ensure proper ribbon operation, make sure that the ribbon is wound with the ink 

side out, feeds off the back of the Ribbon Supply Spindle, runs under the print 
head, and is re-wound on the Take-Up spindle starting from the back. 

 
When properly loaded as shown in Figure 2, the Ribbon Supply will rotate clockwise 
and the Ribbon Take-Up will rotate counter-clockwise. Proper ribbon loading technique 
is also shown on the diagram inside the Tubing Access Cover. 
 
You can find a video detailing this procedure on the web: http://www.SumiSupport.com 
 

  

Ribbon 
Supply 
Spindle 

Ribbon 
Take-Up 

Spool 

Print Head 
Latch 

Side Access 
Door 

Tubing Access 
Cover 

http://www.sumisupport.com/


 

7 

  

 

Procedure 1b – Loading SumiMark Tubing 
 

 
Figure 3a 

 

1. Open the Tubing Access Cover.                                          
2. Rotate the green Print Head Latch counter-clockwise to open the print head. 
3. Open the Side Access Door to allow the tubing to be loaded.  
4. Slide the SumiMark® tubing spool onto the freestanding Spool Assembly. 

Tubing should be feeding from underneath the spool and into the Tubing 
Access Slot from the back of the SumiMark printer. 

5. Route the SumiMark tubing through the three (3) 
Tubing Rollers as follows: 

a. First, guide the tubing under the Print 
Head and out through the cutter. Refer to 
Figure 3b. 

b. Slide the tubing over the Primary Tubing 
Roller between the red guide fingers. 

c. Slide the tubing under the 2nd Tubing 
Roller between the adjustable rollers. 

d. Slide the tubing over the 3rd Tubing 
Roller between the adjustable rollers. 

6. Adjust the Tubing Guides on each roller until they are a hair’s width from, but 
not touching, the tubing on each side. Important: The tubing should move 
freely between all guides. 

7. Close the Side Access Door and turn the Print Head Latch clockwise to the 
fully closed position. 

 
You can find a video detailing this procedure on the web: http://www.SumiSupport.com 

  

Print Head 
Latch 

Side Access 
Door 

 

Tubing Access 
Cover 

Tubing 
Access Slot 

3rd Tubing 
Roller 

2nd Tubing 
Roller 

Primary Tubing 
Roller 

Figure 3b 

http://www.sumisupport.com/
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Procedure 2a – Changing the Cutting Block & Blade 
 

 
Figure 4 

 

• To access the Cutting Block and Cutting Blade in your SumiMark printer, begin by 
removing the Cutter Cover, held in place by two flathead screws at the front of the 
machine.  
 

To Change the Cutting Blade:  

1. Loosen the two Set Screws holding the current blade in place, then slide out the 
blade.  

2. Replace with the blade of your choice (straight-edge or perforated) then tighten the 
Set Screws to secure it.  
 

To Change the Cutting Block:  

1. Locate the four Allen screws securing the front portion of the Cutter Head and 
remove them.  

2. Inside the cutter head will be the white Cutting Block; use a flathead screwdriver 
or other tool to pry it loose, sliding it free of the Cutter Head. 

3. Rotate the Cutting Block or replace as necessary, securing the Cutter Head again 
with the Allen screws after.  

 
After completing your work, replace the Cutter Cover, and you’re ready to print!  
 
You can find a video detailing this procedure on the web: http://www.SumiSupport.com 
 
  

http://www.sumisupport.com/


 

9 

  

Procedure 2b – Cutter Reset 
 

 
Figure 5 

 
To perform a Cutter Reset: 

1. Power the printer off 
2. Locate the small Cutter Reset Button, identified in Figure 6 above and situated to 

the right of the Ribbon Supply Spindle. 
3. Press and hold the reset button, then power the printer back on 

 
The printer should cycle one time to reset itself. If it does not move, it may require an 
adjustment to the Cutter Sensor Clip; call SumiMark Technical Support at (760) 
761-0600 ext.255. If the cutter continuously cycles when powered back up, look into the 
printhead from the front and release the button when the blade is at its lowest point. This 
may take a few tries to get correctly. Once the reset is complete, you may proceed. 
 

1. Release the Cutter Reset Button 
2. Press the FEED button, and verify that the “Cutter Failed” error does not reappear 
3. Attempt a small test print of 2-4 markers, and verify that the “Cutter Failed” error 

does not return prior to resuming normal printer operations.  
 
  

Cutter Reset Button 
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Procedure 3a – Print Quality Adjustments 
 

 
 
 
Using the Printhead Latch and certain software settings, you can make adjustments to 
achieve optimal print quality in mere moments. First, inspect the Printhead Latch to 
determine its current setting. (e.g. 6 o’clock “fully closed” position, Slot 1 - 3 from left to 
right, refer to Figure 6b)  
 

1. For all tubing, set the Printhead Latch initially to the 6 o’clock “fully closed” position 
2. For 1/4" and smaller tubing, if the 6 o’clock “fully closed” position does not result in 

quality printing, set the Printhead latch initially to the Slot 2 position (middle slot of 
the three) 

3. For sizes in between 1/2" and 1/4" inch, or for ongoing print quality issues, adjust 
the Printhead latch as needed, moving to Slot 2 if initially fully closed, or trying Slot 
1 or 3. (Note: the smaller the tubing, the less pressure it requires for good printing. 
For example, if you find that using 1/4 inch tubing with the Slot 2 position continues 
to produce smudging, try the Slot 3 position furthest to the right) 

4. If the print quality is still poor, try slowing down the print speed and turning up the 
temperature in the Default Print Settings. Within SumiLabel, navigate to 
Options -> Printer Options, select your printer, then click Default Print 
Settings. Try turning the speed down to 2.00"/s (50.80mm/s) or lower, and set 
the temperature to 15.  

o Another option to consider is to add additional pressure through the use of 
the Shim in the Printhead. Refer to Figure 6a, and relocate the Plungers 
inward toward the Printhead Spring, positioning them over the arms of the 
metal Shim. This will often improve print quality on larger tubing sizes (1” 
and larger) and may improve print quality with smaller tubing sizes under 
certain conditions. 

o Also for larger sizes (1” and larger) it may be advisable to use the Lateral 
Printhead Adjustment to adjust the distribution of pressure across the 
tubing for a more even print. This will not usually have an effect on smaller 
tubing sizes, and should be set to 0 in almost all cases.  

o Please note: Do not set the temperature any higher than 15 unless directed 
to do so by a SumiMark technician. You risk melting the ribbon and causing 
damage to the machine. 

5. Despite the appearance of the ribbon, it is not generally the source of smudging. 
Only adjust the ribbon if directed to do so by a SumiMark technician.   

Figure 6a Figure 6b 

Plungers 

 

Shim 

 

Printhead Spring 

 

Printhead Latch 

 

Slots 1-3 

 

Lateral Printhead 
Adjustment 
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Procedure 3b – Routine Maintenance 
 

 
Figure 7 

 
a) After every 1,000ft. roll of ribbon, clean the printhead with isopropyl alcohol and a 

cotton swab. Open the printhead via the printhead latch, lower the access door, and 
insert the swab from the side. Run back and forth across the printhead surface 
completely five (5) or more times to ensure that the printhead is properly cleaned. 

o To reduce the amount of cleaning required and prevent unnecessary wear on 
the printhead, it is advisable to store heat shrink tubing and ribbons in their 
original boxes with their plastic sheeting, if applicable. This will prevent dust 
and debris from gathering on the material and damaging the printhead. 

b) When performance of the cutter begins to affect printing, refer to Procedure 2a to 
inspect, rotate, or replace the cutting block and cutting blade as needed. It is 
advised to change out the cutting block after a maximum of four (4) rotations, 
cutting on each side and rotating end to end for an additional two times per side as 
needed. 

 
Be aware of the following safety protocols: 

1. Never operate your SumiMark printer without the clear plastic Cutter Guard in place 
2. Never attempt to insert any foreign object into the printer not necessary for printing 
3. Always unplug your unit prior to performing any maintenance 
4. Always operate the unit with the Tubing Cover closed 
5. Never attempt to hold or move tubing as it travels through the printer 
6. Ensure that the printer is always connected to a power surge protection system 

 
If you have any questions, comments or concerns, feel free to contact SumiMark Technical 
Support at Identification@seipusa.com or give us a call at (760) 761-0600 ext. 255  

mailto:Identification@seipusa.com
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II. Software Installation 
 
 
Included with your new SumiMark® printer will be a USB flash drive containing several 
pieces of software—including SumiLabel and IMM—which work in tandem to provide a 
world-class marking experience. The software suite can be installed in several different 
ways, depending on the needs of your organization.  
 
An internet connection is required for activation of the IMM and Sumilabel software. SEIP 
understands that not all organizations have the required connectivity and security 
permissions to allow this. If necessary, the installation and activation process can be 
completed over the phone or e-mail, at your discretion.  
 
The foundation of the SumiMark® experience is IMM, which should be installed first. 
 
 

Installing IMM 
 
IMM, or the “Inventory Management Module”, is the portion of the software suite which 
handles the QR Codes used for inventory control. Spools of SumiMark® and SumiTag® 
tubing are stored and processed by their unique code within this module. 
 

 
Welcome to the IMM wizard 

 
As advised by the “Welcome” screen, you would do well to close other applications during 
the installation process.  
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License to fill (your inventory with product) 

 
As with all software, the use of IMM is bound by an End User License Agreement. Be sure to 
peruse the agreement and select “I accept the agreement” once you are satisfied. 
 

 
Just the basics 

 
The Readme included with IMM Setup familiarizes you with the system requirements, 
installation steps, and contact information for technical support. Take a look and click “Next 
>” when you’re ready.  
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Pick a folder, any folder 

 
If you like, you may change the directory to which IMM will be installed. The default 
directory is “C:\IMM_Server”, but it can be modified as necessary to best suit your situation. 
The “Browse…” button will open another window with a Folder Browser to assist you in 
selecting IMM’s new home.  
 

 
The beginning of a beautiful friendship 

 
If you wish to customize the Start Menu folder that will be generated when IMM is installed, 
you may do so on this screen. If you wish to prevent Setup from creating a Start Menu 
folder, simply check the box labelled “Don’t create a Start Menu folder”.  
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IMM ready to go 

 
The “Ready to Install” screen is your last opportunity to review the details of the installaiton 
before Setup proceeds to make them a reality.  
 
NOTE: After you click “Install”, you will be required to uninstall the software if you are 
dissatisfied with the installation directory, Start Menu folder, shortcuts, and more. Be sure to 
review this page to your satisfaction before continuing.  
 

 
Watching installation bars fill is a reward unto itself 

 
Give Setup a moment to process the installation tasks . . .  
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Enjoy! 

 
The IMM is installed and ready for activation and setup in Sumilabel! Your IMM Activation 
Serial Number is included in the accessory packaging. You can perform a self-activation with 
an internet connection. If you do not have an internet connection or are having problems 
with the activation, please contact us at 1+(760) 761-0600 ext203 or via email at 
Identification@seipusa.com. 
 
 
 Once Sumilabel is installed, you will need to set up the IMM server within the software. 
 
Setup IMM within Sumilabel: 
-Go to Sumilabel Explorer 
-Click on TOOLS 
-Select INVENTORY 
-Select IMM SERVER SETUP / The server name, port and discovered servers should have 
automatically populated with the PC info 
-Select VERIFY then YES 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

file://///seipusa.com/public/shared/Identification/Identification@seipusa.com
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Installing SumiLabel 
 
SumiLabel is the main portion of the software suite. It is where the markers are created, 
edited, and ultimately dispatched to the printer.  
 

 
Welcome to SumiLabel! 

 
Installing SumiLabel is as easy as following the prompts. 
 

 
License now, registration later 

 
As with all software, the use of SumiLabel is bound by an End User License Agreement. Be 
sure to peruse the agreement and then select “I accept the agreement”. 
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Just the basics 

 
The readme included with SumiLabel setup familiarizes you with the system requirements, 
installation steps, and contact information for technical support. Peruse the information to 
your satisfaction, then click the Next button.  
 

 
What’s your destination? 

 
If you like, you may change the directory in which SumiLabel will be installed. The default 
directory is “C:\SumiLabel”, but it can be modified as necessary to best suit your 
organization’s particular configuration of storage drives and directories. The “Browse…” 
button will open another window with a Folder Browser to assist you in selecting 
SumiLabel’s new home.  
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Unlimited edition 

 
It is very important that you select the proper edition of SumiLabel software during 
installation for proper use. Selecting the wrong edition can result in unexpected software 
behavior, and a reinstall may be required to correct the issue. Choose “SumiMark” then click 
the Next button to proceed. 
 

 
Let’s start something new 

 
If you wish to customize the Start Menu folder that will be generated when SumiLabel is 
installed, you may do so on this screen. If you wish to prevent Setup from creating a Start 
Menu folder, simply check the box labelled “Don’t create a Start Menu folder”.  
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And the kitchen sink 

 
If you wish to have SumiLabel shortcuts on your Desktop or in your Quick Launch bar, 
check the appropriate boxes here, then click “Next >” to continue. 
 

 
Final review 

 
The “Ready to Install” screen is your last opportunity to review the details of the installation 
before Setup locks them in.  
 
NOTE: After you click “Install”, you will be required to uninstall the software if you are not 
content with the installation directory, Start Menu folder, shortcuts, and more. Be sure to 
review this page to your satisfaction before continuing.  
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That’s the sound of progress 

 
Give Setup a moment to process the installation tasks . . .  
 

 
Let’s label some markers, shall we? 

 
And then you’re done! Sumilabel is installed and ready for activation. Your Sumilabel 
Activation Serial Number is included in the accessory packaging. You can perform a self-
activation with an internet connection. If you do not have an internet connection or are 
having problems with the activation, please contact us at 1+(760) 761-0600 ext255 or via 
email at Identification@seipusa.com. 

 
 

Installing the Printer Driver 
 
If you have just installed SumiLabel for the first time on the PC, it will be necessary for you 
to install the printer driver. To install the printer driver, it will have to be obtained. 
 

file://///seipusa.com/public/shared/Identification/Identification@seipusa.com


 

22 

  

 
Next on our tour of SumiMark … 

 
Take a moment to peruse the license agreement and accept at your leisure. 
 

 
Unpacking 

 
Despite the title of this screen, this is not in fact the directory for the driver installation, but 
the location where the driver wizard will be unpacked. The default should suffice in most 
instances. 
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Final selection 

 
Once the driver wizard is unpacked and ready to use, you can choose to run it immediately 
by checking the appropriate box on this screen. If you wish to view an .html copy of the 
driver wizard’s installation instructions, you may check the other box here, but thanks to this 
manual, the instructions should be superfluous.  
 

 
Putting the driver behind the wheel 

 
If you’re installing a SumiMark® for the first time on a fresh host computer, you should see 
the above screen. If you see an additional option titled “Upgrade printer drivers”, pelase 
contact SumiMark® Technical Support before continuing. Otherwise, choose “Install printer 
drivers”. 
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How to go from A to B 

 
By default, when you reach the “Connect Printer” screen, USB will be selected. It is advised 
that you select “Other” and then click “Next >”, following all subsequent instructions closely.  
 

 
The Other side 

 
Ensure that the printer is on, and connected to the PC via USB, or connected to the network 
via ethernet.  
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Latest and greatest 

 
Choose the model of your printer from the list. Note that the “Sumitomo SumiMark 4” driver 
is not compatible with the SumiMark® IV 300dpi.  
 
 

 
Virtually a USB port 

 
If you are going to connect your printer and host computer using Ethernet, click on “Create 
Port…” and proceed to the section of the manual labeled Print Driver Installation – 
Section B (Ethernet). Otherwise, continue with the next picture.  
 
With the printer connected via USB, the computer should automatically have allocated 
“Virtual printer ports” for interfacing with the printer. Choose “USB001”, or whichever is the 
first not assigned to another printer if you have multiple printers connected.  
 
If there isn’t a “USBXXX” Virtual printer port available, verify that your printer powered on 
and is connected via the USB cable to the host computer you are attempting to install the 
driver on. Attempt to plug it into another USB port if need be, restarting the Seagull Driver 
Wizard if you do try another port. 
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A printer, by any other name ... 

 
Here, you can specify a name for the printer when it shows up in SumiLabel and other 
software. For example, if you are running two SumiMark® printers via your company’s LAN, 
you might name one SumiMark A and the other SumiMark B. If you’re only running one 
printer, you might leave it as is.  
 
NOTE: It is not advised to check “Use this printer as the default browser,” as Word 
documents or other files may be accidentally printed on the SumiMark®. 
 
Regardless of your settings for printer sharing, you will need to repeat the process for 
installing our speciality driver along with SumiLabel on each machine that will be sending 
jobs to the printer, so we advise that you leave this set to “Do not share this printer.” 
 

 
At wizard’s end 
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One last progress bar 

 

 
Ready to mark some tubing! 

 
If you were able to select the USB Virtual printer port earlier in the installation process then 
congratulations—after you click “Finish,” your printer driver is installed and is ready to be 
assigned in Sumilabel. 
 
Assign the SumiMark IV printer in Sumilabel: 
- Sumilabel Explorer screen 
-On the Explorer screen click on OPTIONS 
-Select PRINTER OPTIONS 
-Highlight the SumiMark IV 300dpi printer in the System Installed Printers box / Click 
ADD / Printer will appear in Application Printers box below 
-Check the default box next to the printer 
-Click OK 
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Print Driver Section B: (Ethernet) 
 
First things first: let’s set up a new TCP/IP port.  
 

 
IP, IP, hooray 

 
After clicking the Create Port. . . button, You will see a list of “Available Port Types:”—select 
“Standard TCP/IP Port and then click New Port. . .. 

 
The new standard 

 
As with the USB-style driver installation, please verify that the printer is powered on and 
connected before proceeding, this time ensuring that it is connected via Ethernet.  
 
Also, prior to proceeding with the installation, determine an available IP address on your 
Local Area Network, as you will be manually setting that on the next screen. 
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What’s your address? 

 
Enter the IP address determined to be available on your LAN here. As you enter the IP 
address in the top field, the bottom field should automatically populate with a “Port Name”. 
The “Port Name” can be changed to uniquely name this particular TCP/IP configuration in 
the Driver Wizard. The default (where the “Port Name” matched the IP Address entered) is 
encouraged. 
 

 
Sensing a disturbance in the ports . . .  

 
Allow the Printer Port Wizard to verify the details of your manually entered TCP/IP port.  
 
Please Note: The Printer Port Wizard may not be able to verify the newly entered TCP/IP 
port. Bear in mind that this does not necessarily mean the port will not function as 
expected.  
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Force it through 

 
If you see the screen above, simply note that the Printer Port Wizard was unable to verify 
the TCP/IP port (for future diagnostic purposes), ensure that “Generic Network Card” is 
selected under Device Type -> Standard -> drop-down menu, then click Next >. 
 

 
Uniquely Generic 

 
Congratulations! Your TCP/IP Printer Port should now be properly configured, and is 
available for selection when you click Finish and return to the Seagull Driver Wizard’s 
Specify Port prompt.   
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           III. QR Labels and the IMM 
 

 

 Before any printing can take place on the SumiMark IV 300dpi printer, QR footage codes 
from the SumiMark spools will need to be entered into the IMM. 
 
 
  Each SumiMark branded spool will have a QR label available on it (See Example 1).  
This label code provides the software with the digital footage of which is needed to print. 
 
  If your SumiMark spools do not have these labels, please request replacements at 
www.SumiSupport.com. Replacement labels, upon approval and product verification, can be 
provided. 
 
 
 
 
                                                    Example 1 

         

 
 

                    

http://www.sumisupport.com/
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                     Entering Footage in IMM 
 
 
Open SumiLabel. 
On the Sumilabel Explorer screen, clickTools then Inventory. 
  

 
 
 
 
 
 
 
 
When the IMM Client window opens, select Add. 
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On the left side you can see 2 examples of the information that will be used from the labels. 
The blank box on the top will populate after scanning the QR label with a 2D scanner.  
 If a 2D scanner is not available, the bottom 6 boxes is where you can manually enter the 
24 character code. 
 

 
 
 
 
 Once the label has been scanned or manually entered successfully, a confirmation 
notification will appear in the summary area. Select Close. 
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Once the IMM Client window opens, click on Refresh. The recently entered QR label will 
now appear in the listing along with how much footage there is available for printing. 
 
 

 
 
The IMM Client window can now be closed. You are now ready to create your markers. 
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III. Introduction to SumiLabel 

 
 

Note that videos covering the Introduction to SumiLabel and many other topics can be 
found on the SumiMark® Printer Support page at http://www.SumiSupport.com 

 
 
SumiLabel organizes your markers according to an intuitive hierarchy. There are three types 
of items in the chain: Sets, Jobs, and individual Markers. Every Set is comprised of one or 
more Jobs, and every Job is comprised of one or more Markers. 
 
In addition, each Job can use a different type or size of tubing, helping you organize your 
work according to the scope of your projects. When a new project comes along, you’ll start 
by creating a new Set for it. 
 
 

The New Job Wizard 
 

To create a new Set, simply click the  New Set icon or navigate to File -> New -> Set. 
This will open the New Job Wizard, and will be your first opportunity to modify the type, 
size, and base template for your markers.  
 

 
Boundless opportunity 

 
The upper portion of the New Job Wizard window contains several dropdown menus for you 

http://www.sumisupport.com/
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to select the specific product being printed upon. There are three key aspects to each 
product: the Product grade (e.g. SM3-12), the Part number (e.g. 1/2”), and the Product 
name (Automatically populated upon selecting both the Product grade and the Part number, 
e.g. 1/2” Military Grade Continuous Spool). 
 
The lower portion of the New Job Wizard contains the Design Template, where you are free 
to modify the base template used for markers in the first Job of your new Set.   
 

 
Cookie cutter markers 

 
There are several key elements to understand in order to make effective use of the Design 
Template. Note that your choices will apply to every marker in the first Job of your set 
unless otherwise specified.  
 

• “Number of lines (front)” sets the default of number of lines for your markers. 
Got a series of three-line markers you need to make? Up the number of lines to 
three, and away you go! As you can tell, this is for the front side of the marker only. 
But for all intents and purposes, unless you have the SumiTag® DS printer, 
you’ll only be dealing with the “front” side of your markers anyways.  

 
• The “Select font” section controls the style of the marker’s text in terms of font, 

modifiers, and size in the same fashion as any text editor. (e.g. Times New Roman, 
12 pt., Bold, Center Aligned) 

 
• “Default length” defines the default minimum length (in Inches) for your markers. 

When a new marker is added to the Job, it will assume the length specified here, 
with a few exceptions for choosing a length shorter than the combined security 
margins or the length of text in an Auto-adjusting marker.  
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• The “Auto adjust marker length” checkbox will set your markers to automatically 
add length to accommodate the longest string of text or otherwise display all 
elements on your marker. Uncheck this for fixed-length markers—when a line of text 
is too long to fully display, the editor will notify you by changing the text to be red. 
 

• “Marker security margin” allows you to set (in Inches) the amount of blank 
marker to be left at either end.   

 
Use the “Preview (front)” window to verify that your marker template is arranged 
properly, then click OK to progress to the Basic Editor where you can begin entering text.  
 
 

The Set Editor 

 
In the Set Editor, your view should look something like this: 
 

 
Welcome to the Set Editor 

 
The <?> symbol indicates a blank text element on your marker, ready to be filled with 
information. Bear in mind that the <?> symbol is a placeholder; if you were to print this 
marker, the result would be a completely blank marker sized to your default length.  
 
To begin entering text, either double click the marker in question or check “Data entry 
mode” to enter the mode for editing your markers. 
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This is a test of your heat-shrink marking system 

 
You’ll notice that the first text element (or only text element) of your marker has been 
opened for editing—and if you double-clicked the marker, the “Data entry mode” checkbox 
has automatically been checked for you. Note that in the event of multi-line markers, no 
matter where you double-click on the marker, the first text element on the marker will 
always be the first field that is opened for editing. 
 
After typing a line of text, press Enter on your keyboard to confirm the contents of that text 
element and move on to the next element. If there are no additional lines of text on the 
marker (or if there’s only one to begin with) then the number of copies field for this marker 
will be highlighted. By default, Sumilabel assumes you’re going to want at least one of each 
marker, so this field will automatically have “1” upon creation of a new marker. You can 
change the default number of copies in the User Options.  
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Copy that 

 
As you look at your markers in the Basic Editor, you’ll see a column to the left labeled “ID” 
and a number. That number is the position of that marker in the Job. For instance, ID 1 is 
marker #1 in this job, ID 2 is marker #2, and so on. 
 
When a marker is not currently selected or being worked on, the column to the right, 
labeled “Information”, shows the number of copies of that marker. For instance, ID 1 and a 
3 to the right indicated that three (3) copies will be made of marker #1 if the job is sent to 
the printer without modification. 
 
After choosing the number of copies for a given marker, pressing Enter again will 
automatically create another marker based on the design template you created for 
the set, and will open up the field text element for editing.  
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Another day, another marker 

 
Enter the text as desired and set the number of copies for your next marker. Repeat until 
you’ve entered all of your markers, then uncheck “Data entry mode”.  
 
Unchecking “Data entry mode” will lock the markers and prevent editing without checking 
the box again or double-clicking a marker. Other options for manipulating markers are 
available to you as long as you’re not in “Data entry mode”, visible from the context menu 
opened by right clicking with any marker selected.  
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Context is everything 

 
From the context menu, you can choose to: 
 

• Add another marker to the end of the Job 
• Insert a marker at the selected position (ID) 

• Duplicate the selected marker 
• Drop into editing the selected marker 
• Copy all elements from the front to the back of a marker (Only applicable for 

SumiTag® DS printers) 
• Delete the selected marker 

 
 

Advanced Features 
 
SumiLabel comes with several advanced features that will make the process of developing 
complex, multi-element markers easy as a recipe.  
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Serialization 
 

 
 
The Serialization tool enables you to quickly generate a sequence of numbered markers, 
counting from any number to any other number you please.  
 
The “Start Value” and “End Value” serve as the bookends, between which the tool will fill 
the empty space with all the intervening markers. The “Step” value defines how much the 
tool will count from marker to marker. The Preview shows the result of the current settings. 
 
For multi-line markers, you can choose which of the text elements is to be serialized, and 
using the “Padding” field, you can define a static, unchanging prefix or postfix for your 
serialization. Bear in mind, however, that all other text lines on the generated markers will 
be blank. 
 

 
 
The Advanced tab of the Serialization tool might seem sparse at first glance, but the power 
behind the Padding feature justifies the Advanced designation.  
Once you check “Padding enabled”, you’ll find the “Padding type” and “Padding string” 
sections unlocked and ready for input.  
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“Padding type” designates to which side of the serialization the “Padding string” will be 
found, and defaults to Left. Within the padding string, you can specify placeholder digits for 
the serialization on the appropriate side with zeroes. (e.g. “S/N00” and type Left means that 
you have up to two digits for serialization before other characters in the padding begin to be 
overridden.) 
 
With the type set to Left, the string of text will precede the serialization in the finished 
product. It is best to consider that the actual serialization will occur on the opposite side of 
the string than the padding. (e.g. Type Left means the serialization will occur on the right 
side of the string.) 
 
Choosing the wrong “Padding type” means that data could potentially be overridden in the 
serialization process if the wrong side is specified as padding vs. where the placeholder 
digits are. Be cautious before you proceed to verify that all settings are correct.  
 
The “Start On” box enables you to start serialization at thee marker that was selected when 
you opened the Serialization tool, or to specify a specific marker to begin serialization from.  
 
 

Advanced Editor 

 
Used for adding important marker elements like graphics and barcodes in addition to 
positioning and scaling, the Advanced Editor can be your one-stop-shop for all things 
marker editing—that is, if you’re willing to brave the awesome responsibility that comes with 
such unbridled power. 
 

 
 
The Advanced Editor considers every individual bit of your marker to be an Element—be it a 
line of text, a graphic, or a barcode. You can add, move, scale, rotate, and edit Elements 
from within the Advanced Editor.  
 
 
Please Note: When saving changes to a marker in the Advanced Editor, before exiting the 
window, navigate to the “File” menu to view your options. To save a template of the marker 
as it appears, choose “Save” or “Save As”. To apply the changes made in the Advanced 
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Editor to the marker that was selected, choose “Apply”. If you wish to overwrite every 
marker in the Job with every element exactly as it appears in the Advanced Editor, choose 
“Apply To All”.  
 
The same goes for exiting the Advanced Editor. When prompted to save changes to the 
page (marker), “Yes” will save the changes to the individual marker, while “Yes to All” will 
overwrite every marker in the Job. 
 
 
At the left side of the toolbar along the top of the workspace, you will find buttons to insert 
each type of element: Text, Barcode, 2D Barcode, Image, followed by the Rectangle, Line, 
and Circle shapes.  
 
Adding elements is as simple as clicking the appropriate icon, then positioning the element 
within the marker by clicking and dragging it. The image above shows the blue bounding 
box for the text element on the marker.  
 
By right-clicking on an element, you can open a context menu that includes many different 
options, one of which is the element’s Properties.  
 

 
 
 
The Properties window for an element within the Advanced Editor opens up every aspect of 
the element for you to modify as desired. For a Text Element, you’re able to change the 
text, font, font size, style, and alignment, among other attributes.   
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Additional Resources 
 
For more information on SumiLabel, including recaps of the information contained in this 
manual and explanations of more advanced features like Variables and the Data Import 
Wizard, take a look at the support documents and videos available on the web: 
 
http://sumitomo.freshdesk.com 
http://www.SumiSupport.com 
 

  

http://sumitomo.freshdesk.com/
http://www.sumisupport.com/
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Technical Support 
 

If you have any questions, comments, or concerns, please contact our Technical Support 
department. 
 
Sumitomo Electric Interconnect Products, Inc. 
915 Armorlite Drive 
San Marcos, CA 92069-1440 
 
Email: 
Website: 
Phone: 
 
Please have the following information available: 
 

• Your computer’s Operating System and version of SumiLabel software you are using. 
Example: Windows 10 and SumiLabel 3.0 Build 300 

 
• The product you are trying to print on. Example: SM3-12 – 3/16 inch 

 
• SumiMark® IV Printer serial number. 

 
 
 
 
 
 
All trademarks and registered trademarks are property of their respective owners. 
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Because of the varied nature of the uses for these products each user should make their own evaluations regarding the 
suitability of these products for their specific application. Sumitomo Electric Interconnect Products, Inc. makes no warranties 
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